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1

Migration of SAP Enterprise Portal 6.0 to
NetWeaver '04

Purpose
This document describes how to migrate the portal (referred to in this guide as EP) and
Knowledge Management and Collaboration (KMC) from Enterprise Portal 6.0 SP2 to NetWeaver
’04.
In terms of infrastructure, the migration transports portal and KMC content from J2EE Engine 6.20
and adapts it to the more advanced Java application server, J2EE Engine 6.40.

The Migration Project
Migration from EP 6.0 to NW ’04 is an important undertaking and is to be approached as a
serious project, including extensive preparation and some downtime. Documentation and SAP
Notes should be read with appropriate attention.
Required Expertise Resources
To perform a successful and efficient migration expert knowledge in the following area is required
or must be available:
•

Application knowledge: specifically, the portal and KMC

•

Database administrator

•

OS administrator

Registration
The migration procedure requires registration by means of a registration key. This is in order to
enable SAP to provide proper support for your migration project.

Scope of the Migration Process
Migrate all EP 6.0 and KM database content to NetWeaver ’04 SP Stack 14 and higher.

The migration process deletes the content that was on the target system (NW ’04)
database prior to migration, including portal content objects (whether native, newly
created, or imported) and configurations of any kind. Migration does not merge
content.

Database and Disk Space Prerequisites
•

The temporary table space on the target system must be at least twice the size of the
source database size.
Most new relational database management system installations have an auto-expand
feature for the temporary table space. The flag for this feature must be on. For MS SQL
Server, this flag is on by default, but this should be verified.

•

Free disk space, or free space on the file system for Unix, on the target system, should be
at least the size of the source system database.

Limitations
•

It is not possible to migrate from one operating system to another, or from one relational
database management system to another.

Although the migration process does not support migration across different
operating systems or relational database management systems, for customers who
want to switch operating systems and/or databases, SAP provides a tool (the NW
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copy ) that is capable of copying database content and adapting it as required,
according to operating system, database management system, or both.
Using the NW copy tool to switch OS or DB, or both, must be done only after the
migration process is completed.
For detailed information on the NW Copy tool, see Homogeneous and
Heterogeneous System Copy for SAP Systems Based at SAP Web Application
Server Java 6.40 SR1, located at service.sap.com/instguidesnw04 → Installation,
and SAP Note 785848. The guide and note include information relevant for SR1 and
later updates.
•

The migration does not support changes to UME configurations. The NW ’04 user
management configuration must be the same as that of the source EP 6.0 SP2 system.

•

The automatic migration process is a database export/import, from the source system to
the target. Changes made in the source portal, which are contained in the file system (for
example, the graphic image on the portal logon screen) are not migrated. Such changes
must be redone in the target portal.

•

Web Report tables are not migrated from EP 6.0 SP2 to NW ‘04; therefore, Web Report
iViews will not work in the NW ‘04 portal.
The more advanced NW ’04 Portal Activity Report feature replaces the EP 6.0 SP2 Web
Report, and the differences are such that the data collected by the EP 6.0 Web Report
cannot be used in the target system.

Leaving the old .PAR files containing Web Report is harmless. See J2EE Engine
and Content with Code [Page 44] if you wish to remove them.

List of Relevant SAP Notes
The SAP notes contain the most recent installation information, as well as corrections to the
installation documentation. Read the installation SAP note before beginning the installation.

Make sure that you have the most recent version of the SAP Note. Find the SAP
Notes related to SAP Enterprise Portal in SAP Service Marketplace, at:
http://service.sap.com/nw04doc → SAP Notes
For all SAP Notes, or for search by number, go to:
http://service.sap.com/notes
SAP Note Number

Title

732458

Migration Enterprise Portal 6.0 SP2 to NW '04 - Central Note

766765

Central Note – SAP EP 6.0 on Web AS 6.40 Release NW ‘04 SR1

832968

Central Note – SP Stack 14 – SAP NW ’04 on Web AS 6.40
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1.1

Overview - The Migration Process

Process
The migration process differs, depending on the components that are installed and the migration
path that you choose.
The migration process has five main phases:
...

1. Installation on the target machine
In preparation for the migration, you install NetWeaver ‘04 SP Stack 14, or higher, on the
target machine.
The target machine must have the same components as the source machine. For example,
if the source machine has a portal and Knowledge Management installation and
Collaboration, you must install both these components on the target machine.

It is not necessary to re-import business packages, which were imported to EP 6.0
SP2. This content is migrated.
For more information about the installation procedure, see Installation of the Target System
- NetWeaver '04 [Page 14].
2. Pre-Migration Activities
There are pre-migration steps that must be performed prior to the migration process. The
portal and Knowledge Management each have their own specific set of pre-migration steps.
See the section, Preparations [Page 17] for the KMC pre-migration information, and
Preparing for the Portal Migration [Page 29] for the portal.

If you are working with and migrating Knowledge Management and Collaboration,
you must perform all the pre-migration steps, for both the portal and KM, prior to the
entire migration process.
This is because KMC requires updated information from the portal in order to
migrate successfully.

Do the portal pre-migration steps before the preparations for the KMC migration.
This is to maintain a proper workflow, since the portal must be live for the its premigration steps and the KMC pre-migration requires you to shut down the portal.
3. Migration of Knowledge Management
If KMC is installed on the source system, then you must begin with the migration of this
component. If KMC is not installed, you can begin with the migration of the portal.
For more information, see Knowledge Management and Collaboration Migration [Page 15].
4. Migration of the portal
For more information, see Portal Migration [Page 28].
5. Post Migration Activities
After completion of the migration processes for both KMC and the portal, perform all
required post-migration procedures. For detailed information, see Post-Migration Activities
[Page 38].
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1.2

Checklist for EP 6.0 to NW '04 Migration

Use
Migrating SAP Enterprise Portal involves a complex collection of activities, including preparatory
and post-migration activities. The migration activities performed may not be identical for all,
depending on the EP installation and configuration, for example, if KMC is not installed with the
portal.
The checklist shows all the activities needed to perform the migration to NW ’04, in sequential
order. The Condition column tells you whether or not the specific activity is relevant for you. Use it
to make sure that all required actions are performed in the correct order.

Procedure
For the sake of clarity, the activities in this guide are largely organized and divided according to
KMC and portal activities. This does necessarily mirror the correct sequence of performance. The
activities referred to in the checklist should be performed in the order they are listed, skipping
those that are not relevant to your system.
It is recommended to print the checklist and follow through the activities, checking them off as
they are completed.
Migration checklist

;

Migration Activity
Install NetWeaver ’04 SR1 and upgrade to SP Stack 14
(or higher) as described in the section Installation of the
Target System - NetWeaver '04 [Page 14].
This includes the workflow for the installation and
upgrade of Knowledge Management and Collaboration.

Condition
For portal and KMC

Back up the system.
After successful installation of NW ’04, it is highly
recommended to use a back-up software solution and/or
hardware mirroring to back up the system, and to back
up the database.
Perform user management configuration as described in
SAP Note 777640.

For portal, only if the user
management engine on the
target system is to use an
LDAP directory as the data
source for user information

Verify the prerequisites to migration as described in:
Migration of SAP Enterprise Portal 6.0 to NetWeaver '04
[Page 1]
Knowledge Management Migration [Page 15]
Portal Migration [Page 28].

Prerequisites for KMC, on
condition it is installed

Read the central note for this migration path, SAP Note
732458.
It is also recommended to review, before starting the
migration, the troubleshooting document attached to SAP
Note 777176. This document is updated from time to
time, and it may contain valuable tips and workarounds.
Obtain a registration key by following the instructions
written in SAP Note 854791.
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Portal pre-migration
Delete principals in an unsupported case from the source
EP 6.0 SP2 portal user management, and create new
users and/or groups having identical properties. See
Preparing User Management Configuration for Migration
[Page 29].

The EP 6.0 SP2 user
management has the
principals “Administrator” user
“Guest” user, ”Administrators”
group,”Guests” group in a
case other than as shown
here.

Download the EP 6.0 SP2 user management
configuration. See Downloading the User Management
Configuration for Migration [Page 31].
Set the environment variables: JAVA_HOME and
DISPLAY. See Portal Migration [Page 28].

Unix OS

Install a configured Oracle Administrative Client on the
target machine. See Installing a Configured Oracle Client
[Page 31].

Working with Oracle database
server

Verify SDM configuration to avoid deployment failures.
See Verify/Preconfigure SDM [Page 33].
Make sure that the Support Platform is up and running.
See step 10 under Migrating the Portal [Page 34].
KMC pre-migration
Verify the correct source system as described in
Checking the Source Version [Page 17].

EP 6.0 SP2 installation
includes KMC

Find out the database name for later use. See
Determining the Database Name [Page 17].

‘’

Find out the system Ids as described in Determining
System IDs [Page 18].

‘’

Perform actions required for the Universal Worklist. See
Pre-Migration Universal Worklist Steps [Page 18]

“

Download the KMC migration tool. See Obtaining the
Migration Software [Page 19].

‘’

Shut down the portal as described in Shutting Down the
Portal [Page 19].

‘’

Before running the migration exporter tool, see Backing
Up the etc Directory on the Target System [Page 20].

‘’

Copy the file system data of local fsdb repositories from
the source to the target system. See Copying Data for
Local fsdb Repositories [20]

‘’

Run the migration exporter tool on EP 6.0 SP2 as
described in Running the Migration Exporter Tool on the
Source System [Page 20].

‘’
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KMC migration
Follow the instructions for Using the Migration Tool [Page
22] for KMC.

EP 6.0 SP2 installation
includes KMC

Run reports for the KM migration. See Running Reports
[Page 23].

‘’

Merge and copy the etc directory to the target portal. See
Merging the Contents of the etc Directory [Page 24].

‘’

Run the database migration tool for KM. If fsdb
repositories are configured, also use the tool to
synchronize the fsdb data that is located on the file
system and in the database. See Migrating the Database
[Page 25].

‘’

Perform the KMC configuration migration as described in
Migrating the Configuration [Page 26]

‘’

Back up the system.
After successful migration to NW ’04, it is highly
recommended to use a back-up software solution and/or
hardware mirroring to back up the system, and to back
up the database.

‘’

Portal migration
Begin migrating the portal as described in Migrating the
Portal [Page 34]
Back up the system.
After successful migration to NW ’04, it is highly
recommended to use a back-up software solution and/or
hardware mirroring to back up the system, and to back
up the database.
Supplementary Tasks
On target system, perform Java system copy as
documented in Homogeneous and Heterogeneous
System Copy for SAP Systems Based at SAP Web
Application Server Java 6.40 SR1, located at
service.sap.com/instguidesnw04 > → Installation.
See text on Limitations [Page 7]

Only if it your project includes
switching OS or DB, or both

KM post-migration
Deploy KMC SDAs. See Deploying KMC Software
Components [Page 38]

EP 6.0 SP2 installation
includes KMC

For additional manual migration steps, see Performing
Tasks Identified by Reports [Page 39]

‘’

Delete irrelevant KMC system IDs as described in
Deleting System IDs [Page 39]

‘’

Perform the post-migration activities related to UWL. See
the following sections:
Post-Migration Universal Worklist Steps [Page 40]
Post-Migration Workflow Steps [Page 41]
Manually initialize ad hoc workflow objects. Initializing
Workflow Templates and Object Types [Page 41]
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Portal post-migration
Adjust properties in order to work with Crystal Reports
and R/3 systems. See Connecting to R/3 Systems and
Crystal Reports [Page 43].
Update authentication for Working with Back-End
Systems [Page 43].

Authorization by means of
logon tickets

Update the Reverse Proxy Filter Configuration [Page 43].

Web.xml parameter values
have been changed

For adjusting J2EE Engine custom configurations and
enabling work with custom code content, see J2EE
Engine and Content with Code [Page 44]

EP 6.0 SP2 includes userdeveloped content and/or
changes to J2EE Engine
configuration

Verify the integrity of user management persistence. See
Editing a Data Source Configuration File for UME
Persistence [Page 44]

Changes made to existing
datasource configuration file

Redo the initial permissions for security zones. See
Reset Initial Permissions for Portal Security Zones [Page
45].
Upgrade the KMC initial permissions. See Reset Initial
Permissions for Portal Security Zones [Page 45].

EP 6.0 SP2 installation
includes KMC

For manual migration information and additional
information, see Theme Personalization, Logging, and
Miscellaneous Properties [Page 45]

Required copy of property files
Changes made to portal
theme, TLN properties, PCD
startup properties
Need new logging information

Run the Support Platform Post-Migration Plug-Ins. See
Running the Post-Migration Support Platform Plug-Ins
[Page 46].
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1.3

Installation of the Target System - NetWeaver '04

Prepare the target system for your migration, by installing NW '04 - SAP Enterprise Portal on Web
AS 6.40.

1.3.1

Planning the Target System

You cannot migrate to a target system on a different operating system from the one on which the
source system resides.
You must migrate to a target system that works with the same relational database management
system (RDBMS) as the source system.
Supported Source and Target Systems
EP 6.0 SP2

NetWeaver '04

Win 2000/ MS SQL 2000

Win 2000/ MSSQL 2000

Win 2003/ MS SQL 2000

Win 2003/ MSSQL 2000

Win 2000/ Oracle 9.2.0.6

Win 2000/ Oracle 9.2.0.6

Win 2003/ Oracle 9.2.0.6

Win 2003/ Oracle 9.2.0.6

AIX 5.2 / Oracle 9.2.0.6

AIX 5.2 / Oracle 9.2.0.6

HP-UX 11(i) / Oracle 9.2.0.6

HP-UX 11(i) / Oracle 9.2.0.6

Solaris 8&9 / Oracle 9.2.0.6

Solaris 8&9 / Oracle 9.2.0.6

If you are working with an MS SQL Server database, which is not installed on the
NW ’04 target machine, you must install, on the target machine,an MS SQL client of
at least the same version as the database server.

1.3.2

Installing SAP Enterprise Portal on the Target System

When you set up the target system, only install Portal and KMC. Do not install any
3rd party applications or custom developments because they will be lost during the
migration procedure.
The migration requires a clean target system. This means that the import of
additional content or the customization of existing content must be performed after
the migration. Do not, for example, import new business packages before you begin
the migration.
Obtaining a running SAP Enterprise Portal on Web AS 6.40 requires the following steps:
...

1. Install the NW '04 SR1 portal.
See the guide Installation Guide - SAP Enterprise Portal 6.0 on Web AS 6.40, located at
service.sap.com/instguidesNW04 → Installations.
2. If Knowledge Management and Collaboration (KMC) are installed on the source system,
install KMC NW04 SR1 on the target system. For more information, see Installation Guide SAP Enterprise Portal 6.0 on Web AS 6.40.
3. Upgrade the portal installation by installing SAP NetWeaver 2004 SP Stack 14 (or higher).
The installation of SP Stack 14 is decribed in Support Package Stack Guide – SP stack 14,
located at service.sap.com/instguidesNW ‘04 → Operation → Cross-NW.
4. If KMC is installed on the target system, upgrade KMC by installing SAP NetWeaver 2004
SP Stack 14 (or higher) for KMC. For more information, see Support Package Stack Guide
– SP Stack 14.
Migration of SAP Enterprise Portal 6.0 to NetWeaver '04
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Knowledge Management and Collaboration
Migration

Purpose
The migration transfers the content of Knowledge Management from an EP 6.0 SP2 system to a
NW ‘04 system.

Prerequisites
SAP Enterprise Portal and Knowledge Management and Collaboration are installed on the target
machine and have the version SAP NetWeaver ‘04 SP Stack 14 (or higher).

Process Flow
Before you begin the migration, read SAP Note 732458. It contains the latest
information on the migration, including corrections to this guide.
When you migrate Knowledge Management and Collaboration, you need to:
•

Migrate Content Management and Collaboration.
This automatically includes the migration of the Universal Worklist (UWL).

• Migrate TREX Retrieval and Classification to TREX 6.1.14.
You migrate Content Management and Collaboration before you migrate the portal.
Migration of Content Management and Collaboration
The migration of Content Management and Collaboration involves a number of steps, which are
explained in detail in this guide. The list below gives you an overview of the steps and shows the
order in which they must be performed. If Content Management and Collaboration is installed on
a cluster configuration, then the migration procedure is the same as for a standard configuration.
However, after the migration, it is necessary to delete old system IDs and check the assignment
of scheduled tasks to systems. For detailed instructions on individual steps in the following list,
see the corresponding sections later in the guide.
...

1. Preparations [Page 17]
a. Acquire a registration key, by following the instructions written in SAP Note 854791.
b. Make sure the source system has the version EP 6.0 SP2 with the patch and hot fix
level specified in the central SAP Note for the EP 6.0 migration 732458.
c. Make a note of the CM database name on the source system.
d. Make a note of the system ID on the source system.
Cluster only:
In a cluster configuration, there are several system IDs.
e. Perform preparatory steps for the Universal Worklist.
f. Download the software for the migration from the SAP Software Distribution Center.
g. On the source and target system, shut down the portal. Leave it shut down on both
systems for the entire migration.
h. On the target system, back-up the etc directory.
i. Copy the file system data of local fsdb repositories from the source system to the
target system.
j. On the source system, run the Migration Exporter tool. The tool stores data from the
source system in an archive file MigrationInput.zip, which you need later for
the migration on the target system. It:
i. Exports the KMC configuration data
ii. Collects system data for the migration

Migration of SAP Enterprise Portal 6.0 to NetWeaver '04
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2. The Migration [Page 22]
a. On the target system, extract the KMC Migration Tool to a temporary folder.
b. Copy the file MigrationInput.zip containing input data for the migration from
the source system to the folder with the KMC Migration Tool on the target system.
c. Use the KMC Migration Tool to:
i. Run reports that identify additional actions that are required for the migration.
ii. Merge the contents of the EP 6.0 and NW ‘04 etc directories.
iii.
iv.

Migrate the database content and synchronize data for fsdb repositories.
Merge the EP 6.0 and NW ‘04 configuration data. If you do not want to keep
custom developments on the target system, remove the corresponding
configuration files.
3. Post-Migration Activities [Page 38]
A number of actions are necessary to complete the Knowledge Management Migration.
You perform the actions on the target system.

You perform these steps after you have finished the portal migration .
a. Analyze the Customer Component and Repository Managers reports that are
generated by the KMC Migration Tool at the beginning of the migration. Perform the
manual migration tasks you identify in the reports that are necessary to complete the
migration.
b. Delete obsolete system IDs:




In a system with a single instance, delete the obsolete NW ’04 system ID.

In a cluster, delete old system IDs and then ensure that scheduled tasks are
assigned to new NW ‘04 system IDs.
c. Perform post-migration tasks for Universal Worklist
d. Perform post-migration tasks for workflow
e. Initialize templates for workflow
Migration of TREX to EP6.1.14
You can migrate TREX before or after the Content Management and Collaboration migration. For
the migration, you install the new TREX 6.1 SR1 version on the same machine as the old TREX
installation. You then migrate the indexes from the old system to the new system.
For more information about the migration procedure, see SAP Service Marketplace at
service.sap.com/instguidesnw04 → Upgrade → Cross-NW → Component Migration
Guide - Search and Classification (TREX)

When you follow the instructions in the migration guide, make sure that you
establish the connection between TREX and the Knowledge Management
application (the client). To do this, you need to configure the TREX Service in the
SAP J2EE Engine Visual Administrator Tool.
After migrating the TREX indexes, apply Support Package Stack 14 ( for TREX). After this
upgrade, the target version is TREX 6.1.14.
For information about the SP Stack upgrade, see service.sap.com/instguidesnw04 →
Operations → Cross-NW → Support package Stack Guide - SAP NetWeaver 04 SP Stack 14.

Results
The Content Management and Collaboration migration moves the EP 6.0 database content and
configuration to the NW ‘04 system and updates them. The EP 6.0 configuration data is
transferred from the file system into the NW ‘04 database.
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Note that the repositories configured in the EP 6.0 system will not be accessible on the target
system. To make them accessible, you need to perform the additional actions that are specified in
the results of the Repository Managers report which checks the repositories.

2.1

Preparations

Purpose
Before you begin the migration, you need to perform a number of preparatory steps.

2.1.1

Checking the Source Version

Use
The source system for the migration must have the version CM 6.0 SP2 with the latest patch.
Before you start the migration, ensure that you have the correct version on the source system.

Prerequisites
Check SAP Note 732458 to find out the patch and hot fix level that is required for the
source system.

Procedure
...

1. Log on to the portal and choose System Administration → Support → Version.
2. Make sure that the patch and hot fix version that is specified in SAP Note 732458 is
displayed. Note that the last 2 figures indicate the patch and hot fix version:
6.0.2.<patch_level>.<hotfix_level>_ContentManagement_Collaboration
If a lower patch version than required is displayed, then you do not have the correct source
version for the migration. In this case, you must update the system before proceeding with
the migration.
If a higher patch version is displayed, you can perform the migration.

2.1.2

Determining the Database Name

Use
Before the migration make sure that you know the name of the CM database. You need to specify
the name when you migrate the database with the migration tool.

Procedure
to specify the name when you migrate the database with the migration tool.On the source system ...

If you are certain that the system uses the default database name wcm, you can skip
this procedure:
...

1. In the portal, access the connection pools with System Administration → System
Configuration → Knowledge Management → Configuration → Content Management →
Utilities → JDBC Connection Pools.
2. In the definition of the connection pools, identify the Database Name and make a note of it
for later use. If the variable %DBSID% appears instead of a database name, then you need
to remember the name specified for DBSID in the config_local.properties file.
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2.1.3

Determining System IDs

Use
You need to find out the system ID on the source system and make a note of it. Later, when you
have completed the migration, you need to delete the ID on the target system because it is
obsolete. The NW ’04 target system uses new IDs.

Cluster only:
In a cluster there are several system IDs. This means you note down several IDs on
the source system for deletion on the target system.

Procedure
...

1. On the source system, log on to the portal and choose System Administration → System
Configuration → Knowledge Management → Configuration → Content Management →
Global Services → System Landscape Definitions → Systems → Content Management
Systems.
2. For later use, make a note of all the system IDs that are displayed.

2.1.4

Pre- Migration Universal Worklist Steps

Purpose
The steps listed below must be performed before migrating Universal Worklist (UWL) information
from Enterprise Portal 6.0 SP2 to NetWeaver ’04.

If only the portal is installed on the source system and you have configured the UWL
according to SAP Note 688830, the configuration is lost during the migration. After
the migration you need to manually reconfigure the UWL on the target system.
SAP Note 688830 explicitly states that SAP does not officially support the
configuration of the UWL if Content Management and Collaboration are not installed.

Procedure
On the EP 6.0 SP2 system:
...

1. Note down the UWL System Configuration details (the system alias and connector
information).
The navigation path is System Administration → System Configuration → Knowledge
Management → Configuration → UWL Configuration → UWL Systems Configuration.

You may take a screenshot or copy the system alias and the corresponding
connector information.
2. Make sure that the User Management information, the SAP R/3 system landscape and
system alias information has been backed up during the portal migration.
Procedure:
a. Navigate to System Administration → System Configuration → System Landscape.
b. Under Portal Content find the systems to which UWL is connected to. These
systems can be under a certain folder or directly under the Portal Content node.

ABCCLNT000 under the folder name UWLTestSystems.
c. Right-click on the system name and choose Open → Object.
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d. Select User Management under the dropdown menu Property Category.
e. Note down the User Management information from the Logon Method (UIDWP,
SAPLOGON or X509CERT)and the User Mapping Type.
f. To display the system alias, select System Alias in the Display dropdown menu.
Note down the system alias for the corresponding system name.
3. Download the XML customization files.

This step is not required if you did not upload any customization file. Do not
download any XML configurations with "(Low)" priority - these configurations were
generated and will be regenerated during the post migration.
Procedure:
a. The navigation path is System Administration → System Configuration → Universal
Worklist Administration. See Universal Worklist Content Configuration.
b. Select Display or Remove Current Configurations and Their Customizations.
Choose Start.
c. Select configuration from the dropdown menu options and choose Download XML.
d. Save the file to your local system..

Previous personalization are not preserved after the migration.

2.1.5

Obtaining the Migration Software

Use
You download the software for the migration from the SAP Service Marketplace.

Procedure
...

1. Access the migration software at service.sap.com/swdc → Download → SAP Support
Packages → Entry by Application Group → SAP NetWeaver → SAP NETWEAVER → SAP
NETWEAVER 04 → Entry by Component → EP Migration. Choose the relevant migration
path and then #OS Independent.
2. Download the file KMC60MIGTOOL_<number>.sar
Where <number> indicates the version of the tool.
Extract the contents to a local machine using the SAPCAR tool:
sapcar –xvf KMC60MIGTOOL_<number>.sar
3. Copy the following file to a temporary directory on the source system:
migrationInfoExporter.zip
4. Copy the following file to a temporary directory on the target system
migrationTool.zip

2.1.6

Shutting Down the Portal

•

On the source system, make sure that all users have saved and checked in their
documents and are logged off.

•

On the source and target system, shut down the portal. To do this, you stop the J2EE
Engine. Leave it shut down on both systems until the end of the Knowledge Management
and Collaboration migration.

•

Cluster only:
Make sure the portal is shut down on all the dialog instances in the cluster.
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2.2

Backing up the etc Directory on the Target System

Use
On the newly installed NW ‘04 target system, back up the etc directory containing system data.
You need this backup if the migration of the etc directory fails. The backup enables you to
restore the original state so that you can repeat the migration.

Procedure
Cluster only:
Perform this step on the central instance.
...

On the target system, back up the etc folder.
Windows:
\usr\sap\<system_name>\SYS\global\config\cm\etc
UNIX:
/usr/sap/<system_name>/SYS/global/config/cm/etc

2.2.1

Copying Data for Local fsdb Repositories

Use
fsdb repositories store resources on the file system and metadata for these resources on the
database. The data in the database is automatically transferred to the target system during the
database migration. However, the data on the file system is not transferred automatically. If it is
stored in a local directory, you need to copy it manually to the target system.

If the file system data for an fsdb repository is stored on a remote share, no special
copy operation is necessary.

Copying File System Data to the Target System
For each local fsdb repository that you want to use on the target system:
1. Create a directory on the target system.
2. Compress the data on the source system and then copy it to the newly created directory on
the target system.
3. Unpack the data on the target system.
4. For later reference, note down the name of each fsdb repository and its root directory on
the target system.
You need the information later during the last phase of the database migration. In this
phase, you adapt the configuration settings of the fsdb repositories so that they are valid for
the target system.

2.2.2

Running the Migration Exporter Tool on the Source
System

Use
You run the Migration Exporter tool to:
1. Export the configuration data
2. Collect data on the source system which is required as input for the migration
The Migration Exporter tool saves both the configuration and input data in an archive file
MigrationInput.zip. The data is required later, on the target system, as input for the KMC
Migration Tool.
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Procedure
Cluster only:
Perform this step on the central instance.
...

1. On the source system, extract the file MigrationInfoExporter.zip tool to a temporary
folder. You downloaded this file from the SAP Software Distribution Center in preparation
for the migration.
Run the tool from the temporary folder. To do this, enter one of the following commands:
WINDOWS
MigrationInfoExporter.cmd
UNIX
./MigrationInfoExporter.sh
The Migration Exporter tool starts, exports the configuration data and further system data to
the file MigrationInput.zip.
2. Remember the location of the MigrationInput.zip file. Later, you copy the file to the
temporary folder on the target system where the KMC Migration Tool is located.
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2.3

The KMC Migration

Purpose
You perform the main steps of the migration with the KMC Migration Tool. You use the tool to run
reports that return information about the system, to merge the contents of the EP 6.0 and NW ‘04
etc directories, and to migrate both the database and configuration.

2.3.1

Using the Migration Tool

Use
You perform all the central migration tasks with the KMC Migration Tool. You run the tool on the
target system.

Procedure
Starting the Tool
Cluster only:
You run the migration tool on the central instance of a J2EE cluster.
On the target system proceed as follows:
...

1. To ensure that you have the authorizations required for the migration, we recommend that
you log on as SAP J2EE Engine administrator.
2. Extract the file migrationTool.zip to a temporary directory. You downloaded this file
from the SAP Software Distribution Center in preparation for the migration.
You can use any extraction tool, for example, WinZip.
3. Copy the file MigrationInput.zip, which contains the input data for the migration, from
the source system to the temporary directory you created in the previous step.
4. Start the KMC Migration Tool.
a. UNIX only: Before you can run the tool, you need to set the execute permission with
the command:
chmod 777 <file_name>
b. To run the tool, switch to the temporary directory and start the script appropriate for
your operating system.
For Windows start:
go.cmd
For UNIX start an X-Session and enter:
./go.sh
The tool opens and offers you all the options that you need to carry out the migration:
Reports, ETC, DB and Config.

Working with the Tool
...

1. When the tool opens, you specify the SAP System Name (SAPSID) to enable access to all
required information during the migration,

FP8
2. Enter a valid registration key in the Registration Key field. To acquire a registration key,
follow the instructions written in SAP Note 854791.
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3. Work through the options in the sequence shown on the initial screen:
a. Reports
b. ETC
c. DB
d. Config
Before you start a new migration step, always check whether the previous step has
completed. If you start a step before the previous one has completed, the data on the target
system will be inconsistent.
For details about each step, see the sections below.

Log File
While the tool is running it writes information to the log file KMCMigrationTool.log which is
located in the directory where you start the migration tool.

2.3.2

Running Reports

Use
The KMC Migration tool includes a number of reports that you run to identify additional actions
that you perform to complete the migration. You run the reports at the beginning of the migration,
but perform the additional actions later after completing the portal migration.

The target KMC system may not start up if you do not perform the steps specified in
the results of the reports after the completion of the portal migration.

Repository Managers Report
This report identifies tasks that are necessary to configure repositories on the targets system
correctly. You need the results of the report later, after the migration of the Portal Platform, to
manually configure the repositories.
For more information, see Performing Tasks Identified by Reports [Page 39]
The report finds out, for example, whether:
•

Local paths and remote paths are accessible and the parameter LocalRoot has a valid
value

•

The LocalRoot Versioning has a valid value for CM repositories

•

W2K Security Manager is in use. On UNIX the report issues a warning.

If you do not want to use the repositories that are configured on the source system
on the target system, you do not need to run the report.

Customer Components Report
The report identifies components that were developed and integrated in the application after the
original KMC installation. These customer components are not automatically transferred to the
target system during the migration. To deal with these components you have two options. You
can:
•

Manually deploy the java classes of the components on the target system. You do this after
the migration of the Portal Platform. For more information, see Performing Tasks Identified
by Reports [Page 39].

•

Decide that you do not need the components on the target system. In this case, you have
to exclude the xml configuration files of the components from the migration to the target
system. You can do this when you run the Config option of the KMC Migration Tool. For
more information, see Error! Reference source not found. [Page Error! Bookmark not
defined.]
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If after the test migration you cannot access KMC, we recommend that you remove
the xml configuration files of the customer components before repeating the test
migration.
If the source system has customer components, the KMC target system will show errors related to
these components after the migration. You can temporarily ignore these errors until after the
portal migration when you manually migrate the KMC custom components. However, make sure
that you only ignore errors which are related to the customer components which are identified by
the report. If you notice other errors, you need to resolve them.

Database Deployment Report
The report determines whether the CM repositories on the source system store data in more than
one database. This check is necessary because only one database instance is permitted on the
target system. All data for CM repositories is stored in the Java schema of a single SAP J2EE
Engine database instance.

If the tool finds out that more than one database is in use, you need to contact SAP
support to get special assistance for the migration.

Procedure
To run a report, proceed as follows:
...

1. On the initial screen of the KMC Migration Tool, choose Reports.
The Report Tool window opens.
2. Specify a folder to store the results of the reports in the field Save reports results into.
3. Select the report you need to execute and choose Run.
The report starts and writes status information on the screen. Errors are indicated in red.
4. Analyze the results of the report. You open the results in the folder you specified earlier or
with File → View latest Report.
5. If the Customer Components or Repository Managers report contains information that
makes further migration steps necessary, perform these when you have run all the options
offered by the KMC Migration Tool and migrated the portal.

2.3.3

Merging the Contents of the etc Directory

Use
In this procedure, the contents of the source (EP 6.0) and target (NW ‘04) etc folders are merged
and copied to the target system.

Procedure
...

1. On the initial screen of the KMC Migration Tool, choose ETC.
The ETC Migration window opens. It shows the Source Folders (EP 6.0), the Target
Folders (NW ‘04) and a Temporary Folder. The Temporary Folder is a working folder that
shows the merge process.
2. Choose Start.
The merge process begins. You can follow the progress in the displayed folders and the
output displayed at the bottom of the window. The time that has elapsed for the merge is
shown in milliseconds. When the process has finished the following message appears:
Etc directory migrated successfully in <milliseconds>

If you need to repeat the merge, you can restore the original etc directory on the
NW ‘04 target system using the backup you made in preparation for the migration.
For more information, see Backing Up the etc Directory on the Target System [Page
20].
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2.3.4

Migrating the Database

Use
You run the Database Migration tool to automatically migrate the EP 6.0 source database to the
NW ‘04 target database. In addition, if the migration process includes fsdb repositories, you use
the tool to synchronize these repositories on the target system.

Prerequisites
On the source and target system make sure that the portal is shut down and the database is
running.

Procedure
To migrate the database:
...

1. On the initial screen of the KMC Migration Tool choose DB.
The DB Migration window opens.
2. Enter the required data as shown in the input table below and then choose Start.
When the migration begins, the bottom part of the screen shows the progress of the
conversion and reports any errors that occur. The time required for the migration varies,
depending on the processing power of the target machine. Normally the process takes
several hours.
3. If fsdb repositories exist on the source system, perform the fsdb synchronization. The FSDB
Synchronization screen, which you require for this task, appears after completion of the
database migration. For the synchronization you:
a. Adapt the configuration settings of the fsdb repositories so that they are valid for the
target system
b. Perform the synchronization which ensures that data on the file system and
metadata on the database are synchronized.
Input for Database Migration Tool

If you are uncertain of the DB user and password, which you have to enter, you can
test it as follows:
Oracle
Open the Enterprise Manager Console with Start → Programs → Oracle →
Enterprise Manager Console. Choose the instance and enter username and
password for CM. If the logon fails, you might need to enter a new password.
MS SQL Server
Open the Query Analyzer with Start → Programs → Microsoft SQL Server →
Query Analyze and use SQL Server Authentication. Enter the user and password for
the CM database. If the login fails, you might need to change the password.
For more information on setting a new password for Oracle or MS SQL Server, see
SAP note 687576.
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User Input Values
Source
DB Server

Enter the IP Address of the machine where the source database
server is installed.
To find out the address enter the command:
netstat –n

DB Type

Enter SQL Server or Oracle.

DB Name

Enter the name of the database. This can be the default wcm or
the name you determined earlier in the connection pools or the
DBSID entry of the config_local.properties file. For more
information, see Determining the Database Name [Page 17]

DB port

For MS SQL Server: Enter the port number for the database.
The default is 1433.
For Oracle: Enter the Listener port for the database. The default
is 1521 or 1527.

DB User

Enter the user with which CM connects to the database.
The MS SQL Server default user is wcm
The Oracle default user is wcm.

DB Password

Enter the password for the CM database connection.

Synchronizing the fsdb Repositories
You perform the synchronization at the end of the database migration, when the FSDB
Synchronization screen appears. The synchronization ensures that the fsdb data on the file
system corresponds with the metadata in the database.

To prevent the loss of fsdb metadata on the target system, you must perform the
synchronization at this point in the migration process.
Proceed as follows:
1. In preparation for the synchronization, configure the fsdb repositories correctly for the target
system. To do this:
a. Select a repository that is displayed on the FSDB Synchronization screen.
The color in which the root repository is displayed changes to green, red or orange.
b. In the table below, find out the meaning of the color and then perform the actions
that are recommended to correct the configuration.
Color

Meaning

Required Action

Red

The root directory that is specified for
fsdb data on the source system does
not exist on the target system.

Click on the path displayed in red and
navigate to the correct directory on the
target system. You created this directory
in preparation for the migration.

Orange

The root directory that is specified exists
on the target system, but does not
contain the data for the fsdb repository
which is selected on the screen.

Click on the path displayed in orange
and navigate to the directory on the
target system which contains the data
for the repository in question. You
created this directory in preparation for
the migration and then filled it with fsdb
data from the source system.
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Green

The repository involved is configured
correctly on the target system

No action

Black

The repository involved is not selected.
Colors indicating the validity of the
configuration are not displayed.

No action

2. Synchronize the data on the files system with the metadata on the database. To do this:
a. Select all the fsdb repositories for which you copied data from the source to the
target system.
b. Click Start to trigger the synchronization process.
The process takes few minutes to complete. When it has finished, you are informed
in the status area of the FSDB Synchronization screen.

2.3.5

Migrating the Configuration

Use
The Config option of the migration tool merges the EP 6.0 and NW ‘04 configuration data and
transfers it from the file system to the database. It also offers a screen to exclude XML files
containing configuration data for custom developments from the migration to the target system.
You exclude these files if:
•
•

You no longer need the custom developments on the target system
The custom developments are incompatible with the SAP NetWeaver version and are not
yet available in the version required for the target system.
Earlier in the migration procedure, you used the Customer Components report to identify
components which were added to KMC after the original installation. The configuration files for the
components are transferred to the target system during the migration of the configuration,
however, without the corresponding java classes. These have to be transferred manually after the
portal migration. If you are certain that you do not need the customer components on the target
system, you can exclude the corresponding configuration files from the migration, using the
Config option of the migration tool.

Procedure
...

1. Close any explorers or applications that are open and can access directories with
configuration data.
2. On the initial screen of the KMC Migration Tool, choose Config.
The KMC Configuration Migration window opens.
The Config option of the migration tool merges the EP 6.0 and NW ‘04 configuration data and
transfers it from the file system to the database. It also offers a screen to delete XML files
containing configuration data for custom developments that are no longer required on the target
system.
3. Proceed as follows:
•

If you want to keep all the custom developments on the target system:
i. Choose Quit.
The KMC Configuration Migration screen opens.
ii. Choose Run to start the migration of the configuration.

•

If you no longer need the custom developments on the target system, remove the
corresponding XML configuration files:
i. Select the XML files you want to exclude from the migration and then choose
Start.
The XML files are removed from the list of migration files and then the KMC
Configuration Migration screen opens.
ii. Choose Run to start the migration procedure
The migration of the configuration begins and displays the status at the bottom of the
window. Errors are displayed in red.
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3

Portal Migration

This migration moves and processes portal 6.0 content to make it compatible with J2EE Engine
6.40, thereby enhancing its infrastructure and bringing it in line with NetWeaver ‘04. The migration
tool is a separate utility implemented by SAPInst.
The migration is an automated process, but requires some manual, preliminary steps as well as
important post-migration procedures.

If your system includes Knowledge Management and Collaboration, the migration for
KMC must be performed before the portal migration. For migrating Knowledge
Management (KM), there are different tools and processes than for the portal. For
more information, see Knowledge Management Migration and Collaboration [Page
15].
For the latest information and updates about the migration process from EP 6.0 SP2 to NW ‘04,
consult SAP Note 732458.

Prerequisites
•

You are running SAP Enterprise Portal 6.0 SP2 with the patch level indicated in the central
note for the EP 6.0 to NW ’04 migration (732458). This is the start version of the portal from
which you are migrating. If you are running an earlier EP 6.0 version, then upgrade your
portal accordingly.

•

The NetWeaver ‘04 portal is installed on your target machine. This is the portal to which
your SP2 content is migrated.

The target NW ’04 portal must be installed as a standalone J2EE Engine—not as an
add-in to an R/3 system and not with R/3 persistence. For detailed information, see
SAP Note 780679.
•

If your NW ’04 installation works with an Oracle server, see the pre-migration activity,
Installing a Configured Oracle Administrative Client [Page 31].

•

If your NW ’04 installation is on a Unix machine, you need to also set the following
environment variables: JAVA_HOME and DISPLAY.

•

Java Virtual Machine (JVM) settings are configured as recommended in SAP Note 723909.

Process Flow
Although most of the migration of the content from the EP 6.0 SP2 machine is automatic, some
manual steps are involved in preparation for migration.
To prepare for automatic migration you must do the following:
•

Perform all required pre-migration activities. See Preparing for the Portal Migration [Page
29] for details.

•

Shut down the EP 6.0 SP2 the source system.

•

Run the migration utility as described in Migrating the Portal [Page 34].

•

Perform post-migration activities. See Post-Migration Activities [Page 38] for details.
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3.1

Preparing for the Portal Migration

Before migrating the old system to the new one, several preparation steps are required. Follow
the instructions described in the sections below. The following topics are included:
•

Preparing User Management Configuration for Migration [Page 29]

•

Installing a Configured Oracle Administrative Client [Page 31] (If working with Oracle
database server)

3.1.1

Preparing User Management Configuration for Migration

All usermanagement data created before migration on J2EE Engine 640, if any, will be deleted.
Only the admin and guest users and the admin and guest groups will remain in the installation,
unless they are replaced by the SP2 data, if such data is available. See the table below for the
various possible flows, and specific recommendations where necessary.

The following principals (users and groups) may exist in the source EP 6.0 SP2
portal:






“Administrator” user
“Guest” user
“Administrators” group

“Guests” group
If they exist in EP 6.0 SP2 in the same case (Title Case) as they appear here, these
users and groups will be migrated to the NW ’04 portal.
These principals must not appear in any other case (UPPER, lower) in EP 6.0 SP2
portal. If such principal data (in an unsupported case) is found during the migration
process, the migration will stop.
In order to avoid mistakes, we recommend not having these principals at all in the
EP 6.0 SP2 portal.

The user “Administrator,” whether created upon installation of NW ’04 or migrated
from EP 6.0 SP2, is added automatically, by the migration process, to the group
“Administrators,” receiving all the permissions associated with that group. The
migrated “Administrator” user also will always take on the password of the existing
NW ’04 user.
After reading the following information, see Downloading the User Management Configuration for
Migration [Page 31] for information on how to download the user management information for
migration.
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UME information – flow at back end
Source of User Information

Back-End Flow and Recommendations

Database only

If no admin or guest users (“Administrator” / “Guest”) exist in the
EP 6.0 SP2 database, the users and their respective passwords
from the NW ‘04 installation are used.
If any users (“Administrator” / “Guest”) or groups
(“Administrators” / “Guests”) exist in the EP 6.0 SP2 database,
this is the data that will be used for NW ’04.
For the “Administrator” user, the password from the NW ‘04
system will be taken. This user will be mapped to the
“Administrators” group during the migration process.

LDAP

If no admin or guest users (“Administrator” / “Guest”) exist in the
EP 6.0 SP2 database, the users and their respective passwords
from NW ‘04 installation are used.
If any users (“Administrator” / “Guest”) and groups
(“Administrators” / “Guests”) exist in the LDAP, these LDAP
users and groups will not be used in NW ‘04 after the migration.
This data will be masked in NW ‘04 to avoid data inconsistency.
The database users and groups from NW ‘04 will be used
instead. These users and groups might not have the same role
mappings or permissions as in EP 6.0 SP2.

To avoid possible data and permission
inconsistency, please make sure that you do not
use the users (“Administrator” / “Guest”) and groups
(“Administrators” / “Guests”) from your LDAP
directory in your EP 6.0 SP2 portal before
migration.
SAP System

If no admin or guest users (“Administrator” / “Guest”) exist in EP
6.0 SP2 database, the users and their passwords from NW ‘04
installation are used.
If any users (“Administrator” / “Guest”) or groups
(“Administrators” / “Guests”) exist in the EP 6.0 SP2 database,
this is the data that will be used for NW ’04.
For the “Administrator” user, the password from the NW ‘04
system will be taken. This user will be mapped to the
“Administrators” group during the migration process.

Please make sure that you do not have any users
(“Administrator” / “Guest”) or groups
(“Administrators” / “Guests”) in your SAP System
before migration.

Migration of SAP Enterprise Portal 6.0 to NetWeaver '04

30

3.1.2

Downloading the User Management Configuration for
Migration

Use
SAPInst cannot extract the user management information from the EP 6.0 SP2 database. You
must download this information from the source portal to a .zip file, the location of which is
supplied to SAPInst for the migration.

Prerequisites
•

You are running EP 6.0 SP2 with the latest patch as indicated in the central SAP Note for
EP 6.0 SP2 migration (732458)..

•

You have read Preparing User Management Configuration for Migration [Page 29].

Procedure
...

1. From the top level navigation of the EP 6.0 SP2 portal, choose System Administration →
Support. Support Desk appears in the detailed navigation.
2. Under Top Level Areas in the work area, choose User Management. The Portal Support
Desk opens for User Management.
3. Under Test and Configuration Tools, choose Status of UME properties. The User
Management Configuration View appears.
4. Choose the Configuration Download tab.
5. Select the Download migration zip file checkbox; then enter and confirm a password of at
least eight characters.
6. Click Download Files and save the file to disk.

The password you define and the location to which you save the files will be
required later for the SAPInst migration.

3.1.3

Preparing for Migration with an Oracle Database

If the target NW ’04 system is running with an Oracle database, you must take a number steps to
ensure a successful migration.

Installing a configured Oracle Administrative Client
If the Oracle server is not on the target machine (which is typically the case), an Oracle
Administrative Client must be installed and configured on the target machine.

Verify that the Oracle user on the source system (EP 6.0 SP2) has the same grants
and permissions as the the Oracle user on the target system.
•

If any grants and/or permissions for the Oracle user on the target system are
missing for the Oracle user on the source system, add them on the source.

•

If there are grants and/or permissions for the Oracle user on the source
system that do exist for the Oracle user on the target system, remove them
from the source.
For example, if the Oracle user on the source machine has the DBA User
role, remove it.
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Set environment variable on Unix
For Unix machines only, set the environment variables ORACLE_HOME, PATH, and
<LIBRARYPATH>.
<LIBRARYPATH> is the environment variable assigned to your operating system that determines
the search path for Shared Libraries. This variable is named on different Unix flavors as follows:
•

AIX – LIBPATH

•

Tru64 UNIX, Reliant UNIX, Solaris, Linux – LD_LIBRARY_PATH

•

HP-UX – SHLIB_PATH

The variables PATH and <LIBRARYPATH> are dependent on the variable ORACLE_HOME. See the
following examples for setting these variables and their values.
Example of Oracle Administrative Client setup for cshell:
setenv ORACLE_HOME /oracle/client
setenv PATH $ORACLE_HOME/bin:$PATH
setenv LD_LIBRARY_PATH $ORACLE_HOME/lib
Go to SAP Note 539922 for more explanations about Oracle 9.2.x installations.

Verify database instance aliases in TNSNAMES.ora (Windows and Unix)
TNSNAMES must be configured correctly to recognize the databases on the source and target
machines.
The database instance aliases in TNSNAMES.ora must be entered according to the
following convention: <SID>_<hostname>, for example POR_ilsun31.
Test TNSNAMES
Test DB connections on the target machine where the Oracle client is configured. To verify that
the database instance aliases in TNSNAMES.ora are properly configured, run the tnsping
command, as follows, <tnsping <SID>_<hostname>>, from the Command Prompt terminal on
Windows, or a shell terminal on Unix.
Run tnsping to the aliases of both <SOURCE DB> and <TARGET DB>.
If the output is returned without errors, TNSNAMES.ora is properly configured. If errors are
returned, consult your DBA for assistance.

Configure database instance aliases in TNSNAMES.ora (Windows and Unix)
On Windows
...

1. Open the Oracle Net Manager utility (from the Windows Start menu, Programs → Oracle →
Configuration & Migration Tools → Net Manager), and go to Local → Service Naming.
2. With Service Naming selected, choose the plus sign (+) icon and follow the wizard. Make
sure to add the database instance aliases of both the <SOURCE DB> and <TARGET DB>.
Be sure to test the use the wizard option for testing the connection when finished.
On Unix
On Unix, you must add the database instance aliases of both the <SOURCE DB> and <TARGET
DB> to the TNSNAMES.ora file using any text editor. See the following sample: (Note how, in this
example, the convention for the database instance name is followed, where <SID> = POR;
<hostname> = ILSUN31.)
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Also note that the Oracle domain is defined as WORLD, and the alias must be written with the
domain name as in the example:
POR_ILSUN31.WORLD =
(DESCRIPTION =
(ADDRESS_LIST =
(ADDRESS = (PROTOCOL = TCP)(HOST = ilsun31)(PORT = 1527))
)
(CONNECT_DATA =
(SID = POR)
(SERVER = DEDICATED)
)
)
POR_ILSUN30.WORLD =
(DESCRIPTION =
(ADDRESS_LIST =
(ADDRESS = (PROTOCOL = TCP)(HOST = ilsun30)(PORT = 1527))
)
(CONNECT_DATA =
(SID = POR)
(SERVER = DEDICATED)
)
)

It is strongly recommended that the manual update of TNSNAME.ora be performed
by a DBA.
Be sure to test the connection using tnsping, after configuration.

Backing up both the <SOURCE DB> and <TARGET DB> is strongly recommended.

3.1.4

Verify/Preconfigure SDM

A possible cause of failure in the midst of the migration process is if a specific SDM property,
which is not set correctly on the target system for starting and stopping the J2EE Engine during
the deployment of SDAs.
For details about how to configure the SDM in order to prevent this from occurring, see SAP Note
795142.
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3.2

Migrating the Portal

Use
Running the migration utility processes and imports your EP 6.0 SP2 content, preserving it for use
after moving to NetWeaver ‘04.

Prerequisites
You have complied with all the requirements to prepare for the migration, as described in the
“Prerequisites” and “Process Flow” parts of Portal Migration [Page 28].

Procedure
Warnings:
•

The migration requires a clean target system. The import of additional
content or customization of existing content must be performed after the
migration. Do not, for example, import new business packages before you
begin the migration.

•

In order to maintain data consistency, EP 6.0 SP2 must not be running during
the migration process.

•

To avoid the possibility of database corruption, do not stop the migration
process, by choosing Cancel, at any time while SAPInst is running. only if it
stops automatically.

•

Verify that the password for the Administrator user, which you are required to
provide in SAPinst (see step 2), is also the password for the Software
Deployment Manager (SDM).
If necessary, this can be checked by verifying the Administrator password in
the J2EE Engine Visual Administrator tool, and then providing the same
password for the SDM.

...

1. After starting the target portal, download the migration tool from the Software Download
Center on SAP Service Marketplace, service.sap.com/swdc → Download → SAP
Support Packages → Entry by Application Group → SAP NetWeaver → SAP
NETWEAVER → SAP NETWEAVER 04 → Entry by Component → EP Migration. Choose
the relevant migration path and then #OS Independent to obtain the SAR file. Download the
tool to some location on the target NW ’04 machine.
2. At the migration tool location on the target machine, navigate to the SAPINST directory.

The user that runs the migration utility must have the same permissions as the user
that ran the installation of the target NW ’04 SR1 portal:
•

On Windows OS, user <SID>admin (for example, A30adm) is recommended

• On Unix, this must be the root user
If the target system OS is Windows:
{

Continue navigation to NT → I386, and run sapinst.exe.

If the target system OS is Unix or Linux:
{

Continue navigation to UNIX → <OS_name>, and run sapinst.

At this point, the migration tool starts the J2EE Engine on the target system, if it is
not already up and running.
3. In the SAP Web AS Java System screen, choose from the selection list the J2EE instance
on which your target NW ’04 portal is running, and enter the account details of the J2EE
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administrator. (This information was defined when the NW ’04 portal was installed.) Choose
Next.
4. The Safe Mode screen, which appears next, is not applicable if your system is not in a
clustered environment.
In Safe Mode, all dialog instances in a clustered environment are shut down except for the
central instance for more efficient deployment. Migration is run in Safe Mode by default. If
you want to remain in Safe Mode after the migration ends (if, for example, you intend to do
any additional installations upon completing the migration process), select the appropriate
radio button.

5.

6.

7.

8.

9.

If you are running KMC, you will need to redeploy the KMC software components as
your first post-migration step; therefore, you may wish to remain in Safe Mode.
For more information on Safe Mode, including how to disable it, see
service.sap.com/instguidesnw04 → Operations → Cross-NW → Support
package Stack Guide - SAP NetWeaver 04 SP Stack 14.
Choose Next.
In the Registration screen, enter a valid registration key and choose Next.
If you do not have a registration key, obtain one by following the instruction in SAP Note
894791.
{
For Windows, go to step 7.
{
For Unix, skip to step 8.
If your portal works with an Oracle database, the next screen you to enter the location of
the classes12.jar file.
This file is typically in the oracle client installation directory, for example,
…\oracle\j92\920\jdbc\lib\classes12.jar).
Enter the system administrator password in the SAP System Administrator Authentication
screen, and then enter either the Windows domain or local machine name, whichever is
appropriate. Choose Next.
In the next screen, enter the details of the UME zip file you downloaded from the portal on
the source EP 6.0 SP2 machine.
For locating the zip file, there is a browse option. The password was defined when the UME
zip file was downloaded from the source portal.
For details, see Preparing User Management Configuration for Migration [Page 31].
In the following two screens, enter the database connection details of your EP 6.0 SP2
portal and your NW ’04 portal respectively.

Make sure that you enter the source database information for the Portal Content
Directory (PCD), and not the KMC (WCM) database.
For the NW ’04 portal, just enter a password, since the other details are of the current
system and are known. All of the database connection details need to be supplied for the
source portal.
10. At this point, the system prerequisites for the migration are checked by the Support
Platform, an SAP-proprietary testing engine for running checks and fixes on portal systems.
If the Support Platform application is not up and running, a dialog appears recommending
that you start it. The dialog also gives you the option of continuing with the migration
without checking the system. This is not recommended.
{
If you need to start the Support Platform:
i.

Log on to the J2EE Visual Admin tool and go Server → Services → Deploy.

ii.

In the Deployed Components pane, go to Deploy Service → Server →
servlet_jsp → sap.com/con.sapportals.supportplatform.
Choose Start Application and in the window that opens, which shows all the
server nodes checked, choose OK.

iii.
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Alternatively, you can start the Support Platform using telnet.
i. Access telnet with:
<machine_name> <portal_port_+_8 (e.g. 50008)>
ii.
iii.
iv.

Log in to telnet with the Administrator user (user from the group
Administrators).
Enter password.
Jump to any server node:
jump 0 (goes to the first server node)
or:
jump <server_id>

{

{

v.

To add the required group of commands, enter the command:
add deploy

vi.

Run the command:
start_app sap.com/com.sapportals.supportplatform

If the service is up (or if you have just started it), and all migration prereqisites are in
place, the migration process begins.
If the Support Package finds the prerequisites to be deficient, one of the following
appears:
•

a Support Platform report in which you can find the issues that need resolving

•

or a message recommending that you manually run the pre-migration plugin
of the Support Platform.
For detailed information about the Support Platform and how to use it, see
The NetWeaver Support Platform, located at help.sap.com/nw4 →
Documentation SAP Solution Manager → English → SAP Library → SAP
NetWeaver → Solution Life Cycle Management → Support Platform.
For greater detail about the Support Platform plug-ins for migration, see
Appendix: Support Platform Plug-Ins for Migration from the Portal of EP 6.0
to NW '04 [Page 48].
11. The Summary screen appears displaying the parameters entered in the wizard. If no
corrections are necessary, click Start to proceed with the migration.
12. Migration begins and the Migration Progress screen appears, which displays the migration
phases and progress bar at the top of the screen. Choose View Log to see the migration
log file, in the event of problems during migration.
A notification appears upon successful completion of the migration.
If errors occur during the migration process, choose View Log to find out the details of the
problems. After verifying the cause of the error, several options are offered by the SAPinst
wizard that runs the migration. For an explanation of these options, see the table below.
For more information about the log file locations, see Checking the Status of the Portal
Migration [Page 47].
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SAPinst Display Options
The following buttons are available on the different SAPinst dialogs, namely the input screens
installation progress screen and the message boxes:
Button

Meaning

Back

Displays the previous dialog for editing

Next

Displays the next dialog for editing

Cancel

Cancels the installation with the following options:
Stop
Stops the migration and leaves the migration files in the state in which
they are at the current point in time. This allows you to continue the
migration later from this point.

Be aware that stopping the migration process manually may result in
corruption to the target system database.
Reset
Resets all migration input files. All files in the installation directory are
removed from the system and no log files are saved. You will have to
start the installation from the beginning again.
Continue
Returns to the installation.
Logoff

Exits the SAPinst dialog only. The SAPinst installation keeps running.
Typical use case:
You need to logoff during the installation from the host where you currently
control the installation, in order to connect from another host to the running
installation. Be aware that you need the installation DVD for that.

View Log

Displays the content of the sapinst.log file during the installation.

Retry

Performs the installation step again (if an error has occurred).
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4

Post-Migration Activities

For the migration process to be complete for both KM and the portal, certain post-migration
activities must be performed after the successful implementation of the respective automatic
migration tools.

4.1

Post-Migration Activities for KMC

Purpose
To complete the migration, you configure repositories and migrate customer components with the
help of the information generated by the migration reports. You also delete obsolete system IDs in
the cluster and determine if it is necessary to reassign users to NW ‘04 roles.

4.1.1

Deploying KMC Software Components

Although migrating from EP 6.0 SP2 to NW ’04 requires that the Knowledge Management and
Collaboration migration be performed before the migration of the portal, the nature of the portal
migration forces the redeployment of all KMC software components as a post-migration activity.

If KMC is installed with the portal, this must be the very first post-migration activity to
be performed.
...

1. This is performed using the Software Deployment Manager (SDM). The SDM, including
related documentation, is to be found at the following J2EE Engine installation path:
/usr/sap/SYS_ID/JCxx/SDM/Program
You need to run the following programs to open the SDM:
{
StartServer.bat for Windows or StartServer.sh for Unix
{
RemoteGui.bat/.sh
If running on Unix, you need an X-terminal for the RemoteGui.sh.
2. Before deployment, reconfigure the deployment configuration settings of the SDM as follow:
a. In the SDM, go to the Deployment tab and choose the Show Deployment
Configuration arrow on the bottom right of the UI screen.
b. Under Deployment Configuration, choose the setting option: “Update deployed
SDAs/SCAs that have any version.”
3. Locate the KMC software components in the KMC folders of the SP Stack 14 (or higher)
upgrade for KMC. (For more information, see Support Package Stack Guide – SP Stack
14.)
Choose and redeploy all the software components in these folders.

It is recommended to perform this redeployment in chunks, and not to try to deploy
all components at once. For example, you may choose one folder at a time. For
some folders it may be desirable to further split the deployment, if necessary.
4. To shut down the SDM server properly, you need to run StopServer.bat/.sh.
5. Restart the J2EE Engine.
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4.1.2

Performing Tasks Identified by Reports

Use
Use the information generated by the Customer Components and Repository Managers reports to
perform additional manual migration steps.

Procedure
...

1. On the initial screen of the KMC Migration Tool, choose File → Latest Reports and open
the report for the Customer Components. Alternatively, you can access the reports directly
in the folder which you specified for the results.
The Customer Components Report identifies components that were developed after the
original KMC installation and which you must therefore migrate manually. It shows a list of
xml configuration files that exist on the target system without corresponding java classes.
You have to deploy the Java classes corresponding to the XML files manually because they
are not transferred during the normal migration procedure.
KMC displays errors on the target system if it registers that xml files point to java classes
that do not exist in the system. The errors no longer occur after the deployment of the
corresponding Java classes.
2. On the initial screen of the KMC Migration Tool, choose File → Latest Reports and open
the report for the Repository Managers. Alternatively, you can access the report directly in
the folder which you specified for the results.
With the help of the report, identify problems related to the configuration of repositories on
the target system and resolve them with the instructions provided. Due to the move from
one machine to another, the configuration of some repositories is no longer valid. For
example, if you have configured a local repository on the source system, then the path to
the repository will no longer be correct on the target system. The report informs you of the
tasks that are necessary to configure the repositories correctly.

4.1.3

Deleting System IDs

Use
After the migration, the system IDs of the old EP 6.0 system and the new NW ’04 system are
active in the configuration. You therefore need to delete the obsolete EP 6.0 system IDs.
Cluster only:
After deleting the old system IDs, you make sure that scheduled tasks are assigned to the new
IDs.

If both the old and the new system IDs are active, an error appears in the
component monitor. To check for the error in the portal, choose System
Administration → Monitoring → Knowledge Management → Component Monitor
KMC → Component Monitor → Services → Landscape Service:
Configuration Error: Cluster mode not enabled
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Procedure
...

1. Log on to the portal and choose System Administration → System Configuration →
Knowledge Management.
2. Choose Content Management → Global Services → System Landscape Definitions →
Systems → Content Management Systems.
The system ID is displayed.
3. Delete the EP 6.0 system ID. You made a note of it in preparation for the migration.
Cluster only:
In a cluster configuration with several instances:
a. Delete all the system IDs that originate from the source system. You made a note of
these in preparation for the migration.
b. Assign scheduled tasks to the new system IDs.

You must explicitly assign tasks to a system ID, otherwise they are not executed.
To assign tasks:
i. Return to Global Services and choose Scheduler Tasks.
A list of scheduler tasks is displayed.
ii. Make sure that the tasks listed are all assigned to the new NW ‘04 system
IDs. Change any assignment that still uses old system IDs.

4.1.4

Post-Migration Universal Worklist Steps

Purpose
The steps listed below must be performed after migrating Universal Worklist (UWL) information
from EP 6.0 SP2, and above, to NW 04.

Procedure
On the NW ’04 system:
...

1. Re-enter the information in the UWL System Configuration.
2. Re-register the item types for UWL system from the UWL admin page.
The navigation path is System Administration → System Configuration → Universal
Worklist Administration. See Registration for Item Types of Universal Worklist Webflow.
3. Re-upload the customization XML.
The navigation path is System Administration → System Configuration → Universal
Worklist Administration. See Universal Worklist Content Configuration.

Additional Information
If you have the Manager’s Self-Service (MSS) installed on your system, see SAP note 646601 for
further details.

The Workflow Execution Handler (Workflow XHandler) is no longer supported as
of the following Business Packages for Manager's Self-Service (MSS):
MSS 50.2.6 or later
MSS 50.3.4 or later
MSS 50.4 or later
MSS 60.1 or later
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4.1.5

Post-Migration Workflow Steps

Purpose
The steps listed below must be performed after migrating Workflow information from EP 6.0 SP2
to NW ’04.

No pre-installation steps are required.

Procedure
After the migration, start the portal.
...

1. Navigate to System Administration → System Configuration → Knowledge Management →
Workflow → Engine. Edit the following attributes:
Database Type = openjdbc
Factory = com.sap.engine.services.jndi.InitialContextFactoryImpl
2. Stop and restart the portal.
3. Initialize Workfllow template. See details below.

4.1.6

Initializing Workflow Templates and Object Types

Use
To enable the use of templates and object types in Ad Hoc Workflow, you need to manually
initialize them.

Procedure
...

1. Log on to the portal and access the workflow templates with Content Administration →
Workflow Content → Workflow Templates.
2. Choose Restore Default Templates.
For Windows:
The default workflow templates are automatically initialized.
For Unix systems:
a. The default templates are not automatically initialized. You must upload the template
manually. The template XML files are available in the following directory:
\usr\sap\<SAPSID>\JC<number>\j2ee\cluster\server0\apps\sap.com
\
irj\servlet_jsp\irj\root\WEB-INF\portal\portalapps\
com.sap.workflow.apps\ private\install\templates
There are seven XML files to be uploaded:
QuickTask.xml
QuickTaskWithoutApproval.xml
RequestFeedback.xml
RequestFeedbackParent.xml
RequestNomination.xml
RequestNominationAnonymous.xml
RequestNominationParent.xml
b. Navigate to Content Administration → Workflow Content → Workflow Templates.
c. Click Load Template From File and upload the above listed seven XML files.
d. From the list of Available Workflow Templates, click the Activate icon from the Action
column to activate the template
3. To access the object types for tasks, enter the following address:
http://<servername>:<portNumber>/irj/servlet/prt/portal/
prtroot/com.sap.workflow.apps.BusinessObject
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4. Choose Browse and then navigate to the folder specified below.

For UNIX replace the backslashes with slashes.
\usr\sap\<SAPSID>\JC<number>\j2ee\cluster\server0\apps\sap.com\
irj\servlet_jsp\irj\root\WEB-INF\portal\portalapps\
com.sap.workflow.apps\private\install\objTypes
5. Select WFTask.xml and choose Upload.
The object types for workflow tasks are created.
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4.2

Post-Migration Activities for the Portal

Use
To complete the current migration process so that migrated EP 6.0 SP2 content operates
satisfactorily in NW ’04, post-migration steps must be performed for the following components:
•

Systems using R/3 template and Crystal Report server

•

Trust to SAP backend systems

•

Reverse proxy parameters

•

J2EE Engine and Content with Code

•

Editing datasource configuration

•

Resetting initial permissions for the portal security zones

•

Upgrading initial permissions for KM

•

Theme Personalization and Miscellaneous Information

•

Running Support Platform plug-ins

4.2.1

Connecting to R/3 Systems and Crystal Reports

Because of properties created subsequent to the release of EP 6.0 SP2, certain steps are
required for the following circumstances:
•

Access required to SAP systems
Two new system properties, where the EP system object is based on the template
Dedicated Application Server for R/3 System:
{
Gateway Host
{
Gateway Service
Enter the appropriate values for these properties in the system object Property Editor under
the default Information category.

•

Access required to data from the Crystal Report server (such when a BW system needs to
bring data from a Crystal Report server)
Three new system properties, where the EP system object is based on the template
Dedicated Application Server for R/3 System:
{
Host name of Crystal Enterprise Server
{
Path of Crystal Enterprise Server
{
Protocol of Crystal Enterprise Server
Enter the appropriate values for these properties in the system object Property Editor under
the Crystal Enterprise Server category.

To open the Property Editor, go to System Administration → System Configuration →
System Landscape; right-click desired system and choose Open → Object.
If you work these systems, consult SAP Note 726750 for detailed information.

4.2.2

Working with Back-End Systems

If you are using systems in the source portal system landscape, which are based on SAP
backend systems, such as R/3, BW, and CRM, and which are authenticated using
SAPLOGONTICKET, you need to recreate the trust between the NW ‘04 portal and the relevant
SAP backend system.

4.2.3

Reverse Proxy Filter Configuration

Reverse proxy filter configurations are not migrated from EP 6.0 SP2 to NW ’04. If you configured
a reverse proxy filter for your portal, which ran on top of J2EE Engine 6.20, you need to redo the
configuration for the new portal, now working with J2EE 6.40.
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The configuration is entered in the web.xml file, located on J2EE 6.40 at the following path:
…\usr\<SAP_system_ID>\<J2EE_instance>\j2ee\cluster\server0\apps\sap.com\irj\servlet_jsp\irj\r
oot\WEB-INF
The web.xml file on J2EE 6.20 is located at:
…\usr\sap\<SAP_system_ID>\j2ee\<<j2ee_instance>_<port>>\cluster\server\services\servlet_jsp\
work\jspTemp \irj\root\WEB-INF\web.xml
If any other custom changes were made to web.xml in SP2, such as the addition of portal aliases
for logon purposes, these must also be copied to the web.xml file on the NW ’04 machine.

4.2.4

J2EE Engine and Content with Code

...

1. If a connection pool was created in EP 6.0 for custom applications, make sure to recreate it
for NW ’04, as it was defined in J2EE for EP 6.0.
2. If EJBs were created and deployed in EP 6.0, redeploy them in J2EE 6.40 for NW ‘04.
If you have customized content using code, or you are running applications specific to SAP
J2EE Engine 6.20, you may be able to convert these to work with SAP J2EE Engine 6.40
using the SAP J2EE Engine Converter and Deploy tools.
For details, see the section on incompatibilities between J2EE 6.20 and 6.40 in the
migration manual for SAP J2EE 6.20 to 6.40 at help.sap.com/nw4 → English → SAP
Library → SAP NetWeaver → Application Platform (SAP Web Application Server) → Java
Technology in SAP Web Application Server → Migration.
3. If additional JARs were copied to EP 6.0, they need to be recopied to NW ’04.
See the section on incompatibilities between J2EE 6.20 and 6.40 in the migration manual
for SAP J2EE 6.20 to 6.40, if necessary.
4. If you have custom tuning and configuration changes, which were made in J2EE Engine in
6.20, and need to find the corresponding settings and system properties in J2EE 6.40, this
information is also covered in the section on incompatibilities between J2EE 6.20 and 6.40
in the migration manual for SAP J2EE 6.20 to 6.40.
5. If the files library.txt or reference.txt were changed in EP 6.0, the changes must be redone
for NW ‘04.
6. If additional HTML files were created in EP 6.0, copy them to the docs folder on the NW ’04
machine, \j2ee\j2ee_<instance_no>\docs.
7. Deploy proprietary portal archives (PAR files).
{
All PAR files in the source system database are migrated to the target system
database.
{
If you have overwritten PAR files provided by SAP with your own PAR files, using
the same name (in order to enhance or customize functionality), these files will be
overwritten in the target system by the new PARs. If you want to have your PARs
running in the new system, you have to manually redeploy them to the NW ‘04
system after migration.
{
If you have created functionality with new proprietary PAR files in the source system,
in order to replace the functionality of existing files, this may end result in duplicate
functionality in two separate PAR files. In this case, remove one of the two par files.
For deploying and removing PARs, navigate as follows:
i.
ii.
iii.

System Administration → Support → Support Desk.
Under "Portal Anywhere" Admin Tools, choose Administration Console.
Use the Archive Uploader to deploy PAR files, and the Archive Remover to
remove them.
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4.2.5

Editing a Data Source Configuration File for UME
Persistence

For User-Changes to Data Source Configuration Files
The user management configuration needs a datasource file for persistence configuration. If a
proprietary datasource file, that is, a copy of an existing datasource file, was used in EP 6.0, this
file will be migrated and will also be used in NW ‘04. If the user has changed an already existing,
SAP-released datasource file, the changes made to this file will be lost after migration to NW ’04.
If a customized datasource configuration file has to be adapted to NW ’04, see SAP Note 751553
for details about how to do this using the offline J2EE Engine config tool.
Also refer to the following documentation in the Help Portal: help.sap.com/nw04 → Language
<English> → Security → Identity Management → User Management Engine → UME
Configuration → Editing UME Properties and Files → Editing UME Configuration Files.

For LDAP with SSL
If you’re using SSL (Secure Sockets Layer) with your portal, you need to edit your data source
configuration file as described in SAP Note 906251.
To access the documentation referred to in the note, go to the Help Portal: help.sap.com/nw04 →
Language <English> → Security → Identity Management → User Management Engine → UME
Configuration → Configuring UME to Use an LDAP Server as Data Source and Customizing a
UME Data Source Configuration.

It is recommended testing the custom datasource file.

4.2.6

Reset Initial Permissions for Portal Security Zones

The migration of EP 6.0 SP2 to NW ’04 overwrites the initial permissions to portal Security Zones,
which were set after the original installation of NetWeaver ‘04. Rectifying this can only be
performed after the portal has been successfully migrated.
For detailed information, see the guide entitled How To Upgrade to the Extended Security Zone
Concept of NetWeaver ’04, located on SAP Service Marketplace at service.sap.com/nwhowtoguides → Portal, KM and Collaboration.

4.2.7

Upgrade the Initial KM Permissions File

After the migration of EP 6.0 SP2 to NW ’04, the KM Security Zone has no initial permissions.
Rectifying this can only be performed after the portal has been successfully migrated.
Perform the steps described in SAP Note 804876.

4.2.8

Theme Personalization, Logging, and Miscellaneous
Properties

Theme Personalization Not Migrated
Users who personalized the theme of their portal, that is, chose a different theme than the portal
default, must choose the desired theme again after migration.

logger.xml Configurations not Migrated
NW ‘04 has new logging mechanism. Logs will be automatically recreated in NW ’04 SR1.

Top-Level Navigation Properties Moved
Three TLN properties were moved in the NW ’04 portal to the navigation.helperservice.
They are ContentArea, InnerPage, PersonalizePortalPage.
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If you have changed the values of these properties in the SP2 system, the look and feel of the
NW ‘04 portal be the default as provided by SAP, and not the same as in your EP 6.0 SP2
system. For information about resetting these values see SAP Note 777176.

Copying Property Files
Property files are not be migrated to NW ‘04. For example, iViews based on CRM 3.1 properties
will not run on NW ’04 until the property files copied manually.

PCD Startup Properties
The file pcdStartup.properties is not migrated. Changes made to this file will not be applied to the
NW ‘04 system, for example, the location of the import folder. After migration, the default provided
by the NW ‘04 portal will be applied. See SAP Note 778977 for detailed information.

4.2.9

Running the Post-Migration Support Platform Plug-Ins

The post-migration plug-ins must be run manually after the migration process is complete. Of the
post-migration plug-ins, five must be run when the portal is offline, two are run when the portal is
online. The order in which they are run does not matter.

It is strongly recommended to run the post-migration plug-ins.

Accessing the Support Platform
There are two ways of accessing the Support Platform:
1. Type your target portal URL in a browser address field with the alias “sp” instead of “irj”
(<hostname>:<port>/sp).
Log on with your regular portal user and password.
2. Alternatively, from within the target portal, navigate as follows: System Administration →
Support (opens the Support Desk page) → Support Platform (opens the Support Platform
general info page), and select the link Click here to open the Support Platform.

Running the Plug-Ins
1. In the Support Platform Plug-ins navigation panel, expand the folders Enterprise Portal →
SP2 to NW04 Migration. The folders Post-Migration and Pre-Migration are exposed.
For detailed information about the Support Platform migration plug-ins, refer to the
appendix of this guide on Appendix: Support Platform Plug-Ins for Migration from the Portal
of EP 6.0 to NW '04 [Page 48].
2. Run all the plug-ins in a folder by selecting the folder and then Run, or select the plug-ins
individually and choose Run. In a cluster environment, you can choose Run on all nodes.
The results are displayed in the Support Platform result panes on the right.
Support Platform documentation:
For detailed information about the Support Platform and how to use it, see The NetWeaver
Support Platform, located at help.sap.com/nw4 → Documentation SAP Solution Manager →
English → SAP Library → SAP NetWeaver → Solution Life Cycle Management → Support
Platform.
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5

Troubleshooting the Migration

In the event of problems incurred during the migration process for KMC or the portal, check the
status of the process as described in the following sections.

5.1

Checking the Status of the KMC Migration

Use
Log on to the target system and check the component monitor to assess the status of the
migration.

Procedure
...

1. In the portal, choose System Administration → Monitoring → Knowledge Management →
Component Monitor.
2. In the component monitor, click Filters, Repository Managers, Repository Services and
Services. For each of these items, check the subentries. Keep in mind that if you have not
yet performed the necessary actions identified by the Repository Managers Report, tool
during the repository check, the repositories will indicate errors:
The colors beside the entries indicate the following:
{
Green shows the object is functioning well.
{
Red shows the object cannot be started or is configured incorrectly.
{
Yellow indicates that one or more lower-level items are red.
3. If Content Management does not start up, there might be a problem with the database
connection. To find out more, check the available log files:

For UNIX, replace the backlashes in the paths with slashes.
...

...

a. Switch to the directory:
<Drive>:\usr\sap\<SAPSID>\JC<J2EE_instance_number>\j2ee\
cluster\server0\log\
b. Open the file defaultTrace.0.trc with the most recent date. If errors appear in
the trace file, try to solve them and then restart the SAP J2EE Engine.

You can also view the trace file using the log viewer that is available in the SAP
J2EE Visual Administrator.

5.2

Checking the Status of the Portal Migration

Since the migration tool is a SAPInst utility, use the SAPInst options, including viewing SAPInst
logs, as described in the section Migrating the Portal [Page 34] in the event of problems during
the migration process.
The disk locations for the SAPinst logs are as follows:
For Windows:
c\program files\sapinst
For Unix:
…\space\sapinst
After the portal migration is completed, the logs can be found under:
<installation folder>\JC<instance
number>\j2ee\portal_misc\MigrationSP2_To_SP9_Logs.
For additional useful information, see the central note for the EP 6.0 SP2 migration to NW ’04
(732458), and the relevant related notes.
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6

Appendix: Support Platform Plug-Ins for
Migration from the Portal of EP 6.0 to NW '04

This appendix is presented as additional information for those interested in more detail about the
migration plug-ins of the Support Platform, which are run automatically by the EP 6.0 to NW ’04
migration utility.
Furthermore, in the event of problems during migration, this information may be helpful for those
providing support to customers.
The plug-ins are divided into two main folders: Pre-Migration, which includes tests which are run
before the migration; and Post-Migration, which includes tests to be run after the migration.
The Post-Migration folder includes two subfolders: the Offline analyze folder includes tests that do
not require the J2EE Engine server to be running; and the Online analyze folder, which includes
tests that require the server to be running. These tests have to be run after the migration has
finished successfully.
Following is a list of the post-migration plug-ins for the portal migration with general descriptions.
More detail follows.
Plug-In Name

Description

Check Migration Logs

Offline analysis
Checks the SP2 to NW04 SAPinst migration logs and returns
status information about the various migration steps.

EPT manifest version scan

Offline analysis
Displays the 'BasicTransport-Version' of all EPT files under the
deployment directory. This test is scans the MANIFEST.MF
file.

ERR files scan

Offline analysis
Displays a list of *.ERR files under the deployment directory.
The location path of these files is displayed to the right.

PAR file scan

Offline analysis
Displays a list of *.PAR files under the deployment directory.
The location path of these files is displayed to the right.

PAR manifest version scan

Offline analysis
Displays the 'Implementation-Version' of all PAR files under
the deployment directory. This test is scans the
MANIFEST.MF file.

Check Systems integrity

Online analysis
Checks the integrity of the System Landscape after migration.
{
Systems with empty properties: Gateway Host
and Gateway Service
{
BW systems with empty properties: Host name of
Crystal Enterprise server, Path in Crystal
Enterprise server, Protocol of Crystal Enterprise
Server

List of deployed SDAs

Online Analysis
Displays a list of all deployed SDAs.
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6.1

Pre-Migration Plug-Ins for Prerequisite Checks

This plug-in checks the following requirements:
1. Database (DB) Type
a. OS type
b. Environment variables were set properly:
i. For all OS and DB:
ii.

•
JAVA_HOME
For Unix only:
•

iii.

DISPLAY

• PATH: has to include $ORACLE_HOME/bin for Oracle
For Oracle DB only:
•

LD_LIBRARY_PATH: has to include $ORACLE_HOME/lib. For AIX:
LIBPATH. For Tru64 UNIX, Reliant UNIX, Solaris:
LD_LIBRARY_PATH. For HP-UX: SHLIB_PATH

• ORACLE_HOME
2. For migration with an Oracle DB:
a. Checks if classes12.jar is available in the correct location.
b. Checks that the tnsnames.ora file has entries in the following format: <source_DB
name>_<source_DB_host> and <target_DB_name>_<target_DB_host>.
3. Checks connection to both source and target DBs based on the properties provided in the
GUI.
4. Checks the version of the DB client.
a. For MS SQL Server, not lower than 8.00.760
b. For Oracle, not lower than 9.2.0.3.0
5. Checks free disk space on the target system.
a. At least 200MB free disk space under /usr/sap/<instance>
b. At least 200MB free disk space under the user's temp directory
Possible results:
Status

6.2

Possible cause

V

Requirement is verified successfully

X

Missing requirement

Post Migration Plug-Ins

Following are the descriptions of the offline and online Support Platform plu-ins for the EP 6.0
migration.

6.3 Offline analyze
Check Migration Logs
This plug-in checks the sapinst_dev log and searches for specific entries (described below).
During the migration, SAPinst writes specific entries in its log for Support Platform to be able to
read them aftewards. It then copies all the logs created during the migration to the following
folder:
\usr\sap\<sys. No.>\JC<inst. No.>\j2ee\portal_misc\MigrationSP2_To_SP9_Logs
The following entries are possible in the log:
MIGLOG001ERROR: Database Migration - Failed!!
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MIGLOG001SUCCESS: Database Migration - Success!!
MIGLOG002ERROR: Export UME Database Content - Failed!!
MIGLOG002SUCCESS: Export UME Database Content - Success!!
MIGLOG003ERROR: Import UME configuration file - failed!!
MIGLOG003SUCCESS: Import UME configuration file - Success!!
MIGLOG004ERROR: Import Ume Content - Failed!!
MIGLOG004SUCCESS: Import Ume Content - Success!!
The Support Platform shows whatever entries it finds in the log. If no entries are found, it indicates
this in its result table.
Possible results:
Status

Possible cause

V

Step succeeded

X

Step failed. Check the sapinst_dev.log for errors.

i

Entry was not found in the sapinst_dev.log. This might be due to a problem in
the SAPinst.

EPT Manifest Version Scan
This plug-in checks recursively the version of the deployed EPT files, which wrap portal content,
under the directory \deployment. The version check is performed based on the property
BasicTransport-Version. There is an entry for this property in the MANIFEST.MF file for all EPT
files created by SAP.

EPT files are content packages, including default content provided by SAP.
Customer-created content is not listed in the MANIFEST.MF.
The value for the BasicTransport-Version property is a number which represents the version of
the file, and can be found in various formats, for example:
Correct version:
649.20040923171229.0000
Old version:
6.2.0.0.200309122213

The version number examples are intended to give an idea of the appearance of the
version value. Version numbers, however, may not be consistent regarding format or
number of digits.
This plug-in checks the first four characters of the version number and decides whether the
version is right or wrong.
It is possible that an EPT will have an old BasicTransport-Version, but will still be
part of the sp2tonw04migrationFilter.txt file, located in the
SP2toNW04MigrationPlugins.jar file, and therefore will be treated as a correct
version. Such EPT files, in this list, are known files with old BasicTransport-Version
values, which are added to the CD, but need no longer be complied.
Possible results:
Status

Possible cause
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V

Version is correct

X

Version is older than SP14

i

MANIFEST.MF file was not found or BasicTransport-Version was not found
This indicates that the content was not created by SAP.

ERR Files Scan
This plug-in scans the files under the \deployment folder and searches for files with extension
.ERR. If files with this extension are found, they are displayed in the result table of the Support
Platform.
Possible results:
Status

Possible cause

V

No files with extension .err were found

X

File with extension .err was found. Need to check why the deployment of this
file failed.

PAR manifest version scan
This plug-in checks recursively the version of the deployed PAR files under the directory
\deployment. The version check is performed based on the property Implementation-Version.
There is an entry for this property in the MANIFEST.MF file for all PAR files created by SAP.
Customer-created PARs are not listed in the MANIFEST.MF.
The value for the Implementation-Version property is a number which represents the version of
the file, and can be found in various formats, for example:
Correct version:
649.20050110103049.0000
6.90.20041216175708.0000
Old version:
6.20.20040913130021.0000
6.0.1.0.0000.20030710.undefined
5.0.2.0.0000.20030204.47991
5.0.3.3.0000.20030812.64272

The version number examples are intended to give an idea of the appearance of the
version value. Version numbers, however, may not be consistent regarding format or
number of digits.
This plug-in checks the first four characters in the version and decides whether the version is right
or wrong.
It is possible that a PAR will have an old Implementation-Version, but will still be part
of the sp2tonw04migrationFilter.txt file, located in the
SP2toNW04MigrationPlugins.jar file, and therefore will be treated as a correct
version. Such PAR files, in this list, are known files with old Implementation-Version
values, which are added to the CD, but need no longer be complied.
Customer-created PAR files will not have the MANIFEST.MF file, so the test will be return the
result ‘i’.
Possible results:
Status
V

Possible cause
•

Version is correct

•

This PAR is part of a Business Package, and thus has the namespace:
com.sap.pct
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X

i

•

Version is older than SP14. New PAR with this name was not deployed:
{
There is no PAR file with a newer version
{
The same functionality is part of a PAR with different name
{
The SP9 PAR was not deployed – search for errors in the
defaultTrace.log

•

Par file might be part of Business Package, but not have the namespace:
com.sap.pct – no problem expected.

MANIFEST.MF file was not found or Implementation-Version was not found

Redeployment of PAR Files
The .ERR suffix means that these file were not deployed for some reason. If .ERR files, or other
PAR files that remained undeployed, are found, you can redeploy them after migration.
To redeploy these files, remove any .ERR suffixes so that all files have only the .PAR suffix.
These files can now be deployed either manually, using the portal Archive Uploader, or by
restarting the J2EE Engine. The Restart will look in the deployment directory for PAR files to
deploy.
For information about the Archive Uploader, go to help.sap.com → Documentation → Language
(English) → SAP NetWeaver → People Integration → Portal → Portal Developer Guide →
Getting Involved → Portal Runtime → Deployment of Applications → Deploying Applications Via
the Archive Uploader.

6.4 Online analyze
Check System Integrity
This plug-in checks the integrity of the System Landscape after migration. It will mark systems
that have one of the following properties empty and performs the following tests:
•

Systems with empty properties: Gateway Host and Gateway Service.

•

BW systems with empty properties: Host name of Crystal Enterprise server, Path in Crystal
Enterprise server, Protocol of Crystal Enterprise Server.
It ignores system templates.
Possible results:
Status
i

Possible cause
System has no value in the mentioned property. It might cause some of the
iViews based on this system not to connect properly until the correct value is
entered and the system is saved.

List of deployed SDAs
This plug-in displays a list of all deployed SDAs, as provided by the SDM repository. It also
checks the version of the SDAs. The plug-in creates a temporary file named
MigrationAnalyzerCreatedList.txt under the J2EE installation folder: …j2ee/portal-misc/
MigrationSP2_To_SP9_Logs.
Possible results:
Status

Possible cause

V

Version is correct

X

Version is older than SP14
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